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Overview 

Hauptwerk 5 is a major new version of Hauptwerk, superseding versions 1-4, including redesigned (and massively 
more powerful and easier to use) audio routing and real-time impulse response convolution reverb functionality in 
the Advanced Edition, and many other changes for all editions. A new licensing system is also used for Hauptwerk 
version 5 (and optionally also for sample sets for version 5 onwards), which is based upon the PACE iLok system 
(instead of the ‘Hauptwerk USB key’ HASP dongle system that was used for versions 2-4). 

Version 5.0.1 has some important bug-fixes, compatibility fixes, and some minor improvements. If you have 
installed version 5.0.0, then we strongly recommend upgrading to it as soon as possible. 

Please have a look through the Changes to Hauptwerk section to find out what’s included. We hope you enjoy it! 

The most current source of information about Hauptwerk is the Hauptwerk website: www.hauptwerk.com. Please 
have a look there too for updated information, downloads, tutorials, known bugs, and lots more.  



Hauptwerk 5.0.1 Release Notice 

3 
 

Licensing, Editions, Prerequisites, Installation, Technical Support, and 
Compatibility 

Please first read the following sections in the current version of the main Hauptwerk user guide (available on the 
Hauptwerk website, or on the Help menu in this version of Hauptwerk). Doing so is especially important if you are 
installing Hauptwerk version 5 for the first time (even if you are upgrading from Hauptwerk versions 2-4): 

• Licensing, editions, and technical support. 

• Hauptwerk prerequisites. 

• Installation: background information. 

• Installing Hauptwerk. 

• Upgrading Hauptwerk. 

Important: if upgrading from Hauptwerk versions 2-4, then please also consult the following sections in this 
release notice, which cover some important changes to be aware of in v5.0.0: 

• Licensing changes. 

• Platform support and prerequisites changes. 

If upgrading from v2 and above then your existing combinations and voicing will be preserved by default. If 
upgrading from v4 then all settings will be preserved by default (although you have the option to reset your 
audio/routing settings to defaults, so that you can reconfigure them optimally for v5). (If upgrading directly from 
v2-v3, then please note that MIDI settings and audio engine preferences will no longer be migrated, although we 
strongly recommended resetting and reconfiguring MIDI settings for v4+ anyway, using right-click auto-detection 
on the relevant virtual controls.)  

All sample sets that worked in v2 and above should work and perform in this version at least as well as they did in 
previous versions, the one important exception being that copy-protected sample sets that were created for v2-v4 
cannot be loaded directly in this version (*). Existing combinations, voicing, and settings should be preserved in 
either case (apart from MIDI settings specifically if upgrading directly from v2-v3, as above). Sample sets in 
Hauptwerk v1 format may be imported and used in this version too. It's our intention that all future Hauptwerk 
versions remain fully and seamlessly backwardly-compatible with this version. 

Upgrades to, and subscription licenses for, version 5 from v1-v4 may be purchased from the Hauptwerk on-line 
shop on the Hauptwerk website or from your re-seller. 

For ‘perpetual’ (non-subscription) licenses, upgrades between minor Hauptwerk versions (for example between 
v5.0.0 and v5.0.1) are free to users with a valid license for v5, but a license upgrade must be purchased to upgrade 
between major versions (for example between v4 and v5), or between different Hauptwerk editions. All version 
upgrades are included with subscription licenses (during the period for which the subscription has been paid for). 

You can obtain the installers for the current version of the Hauptwerk software as a free download via the 
Hauptwerk website. Whether the software functions as licensed software or as an evaluation is determined only 
by the presence or absence of a valid license. 

https://www.hauptwerk.com/
https://www.hauptwerk.com/
https://www.hauptwerk.com/


Hauptwerk 5.0.1 Release Notice 

4 
 

We believe this version is better in every way than previous versions: it's easier to use, more powerful and flexible, 
with greater realism and better performance. Versions 1-3 are considered obsolete and are no longer available, 
developed, or supported in any way. Unless you have purchased (or have been supplied with) an upgrade to this 
version, v4.2.1 will continue to be supported for a maximum period of 12 months from the date you purchased a 
license for it (either a new license or an upgrade), but there will be no more v4 releases or development, and we 
reserve the right not to assist with issues that would be resolved by upgrading to the current version. 

Important note 1: Any given computer (operating system partition) can only have one version of Hauptwerk 
installed on it at any one time. Once a new version has been installed it isn’t possible to revert to a previous 
version without uninstalling Hauptwerk completely (selecting the un-installer's option to remove all settings and 
files) then re-installing the older version, which would wipe any existing settings. Hence there’s no easy way to 
revert to an older version of Hauptwerk once this version has been installed. (In case you do subsequently decide 
you want to revert to a previous version, please do make sure that you use File | Backup ... within the previous 
version before you install the newer version.) 

Important note 2: When installing this version, please make sure that you refer to, and follow, the instructions in 
either the ‘Upgrading or re-installing Hauptwerk’ section of the main Hauptwerk user guide (if upgrading an 
existing installation), or the ‘Installing Hauptwerk’ section (if performing a new/clean Hauptwerk installation). 
Those sections contain some essential steps. 

(*) Additional important notes if upgrading from Hauptwerk versions 2-4: 

• The previous ‘Hauptwerk USB key’ HASP dongle that was used for Hauptwerk versions 2-4 cannot be used 
for licensing this version of Hauptwerk, or for licensing sample sets. 

• The current version of Hauptwerk isn’t compatible directly with copy-protected sample sets that were 
created for pre-v5 versions, so please contact the makers of any such sample sets to obtain upgraded v5+ 
compatible versions if needed. If you have purchased an upgrade to v5, once Hauptwerk v5+ has been 
installed, you will need to migrate any sample set licenses that you may have from your pre-v5 
‘Hauptwerk USB Key’ HASP dongle (which will remove them permanently from that dongle, rendering it 
no longer usable), activate the replacement v5+ licenses for those sample sets in iLok License Manager, 
then use File | Install … to install the updated v5+ compatible versions of the sample sets. Your settings, 
voicing, and combinations for those sample sets shouldn’t be lost in the process. When purchasing an 
upgrade to version 5 you will be sent instructions for the sample set license migration process (which 
involves using a special menu function once, then submitting the resulting file via a website form). 

• Once you have used the special menu function to migrate your pre-v5 Hauptwerk sample set licenses to 
v5+ there is no way to reinstate those pre-v5 sample set licenses, nor to reinstate your pre-v5 Hauptwerk 
license itself. Hence please make sure that you do indeed wish to upgrade before you use the menu 
function to migrate your pre-v5 sample set licenses. 

• On macOS you must use Finder manually to delete your pre-v5 Hauptwerk installation completely before 
installing v5, otherwise a corrupted installation will result. You can use Hauptwerk’s backup/restore 
functions to retain your existing settings/combinations/voicing. The ‘Upgrade/re-installation steps on an 
Apple Mac computer’ section in the main Hauptwerk user guide covers the necessary steps. (These steps 
are necessary since pre-v5 versions of Hauptwerk were installed in a way that isn’t compatible with the 
security changes Apple have made in recent macOS versions.) 
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Changes to Hauptwerk 

All Hauptwerk releases since version 2 are cumulative, thus each includes all changes from previous Hauptwerk 
versions. Changes in version 4 and earlier aren’t listed in this document, but can be found in the version 4.2.1 
release notice (available separately) if needed. 

Changes in version 5.0.1 above version 5.0.0 

• Compatibility: the proportion of RAM that Hauptwerk v5.0.0 asked Windows to allow it to use resulted in 
stability problems on a few Windows 10 PCs. The amount of RAM that Hauptwerk always avoids using has 
also been increased a little, to reserve a little more for the operating system, drivers, background 
processes, etc. 

• Bug-fix: Hauptwerk could freeze if the demand for instantaneous polyphony exceeded the number of free 
voice generators (i.e. if the polyphony demand would completely overload the polyphony limit setting). 

• Bug-fix: Hauptwerk could crash when starting audio/MIDI with certain sample sets if the Hauptwerk 
AU/VST Link was selected for audio (but not MIDI) output. 

• Bug-fix: Hauptwerk would freeze if stopping audio recording if the 'prompt for filename' option was ticked 
and the 'record MIDI' option was not ticked. 

• Bug-fix: a click could be audible with certain pipes when cross-fading to release samples (especially if the 
harmonic-shaping/brightness filters were turned up significantly). 

• Bug-fix: a crash occurred on a few computers when exiting Hauptwerk after successfully performing any 
of the following: restoring a backup, reverting all settings to factory defaults, cancelling launching 
Hauptwerk if any audio/MIDI devices were missing, or via 'Exit', 'Shut computer down' or 'Re-start 
computer' from the File menu. 

• Memory usage for the Advanced Edition's audio mixer/routing has been significantly reduced, compared 
to v5.0.0. (However, when audio/MIDI is active, v5 does still need to use a bit more memory than v4 for 
its voice generators, which are 8-channel surround-capable in v5 whereas v4's were stereo.) 

• Compatibility: since a few PCs have performance/stability issues if running Hauptwerk at real-time 
priority, the 'Try to run Hauptwerk at real-time priority on Windows' advanced general preference now 
defaults to un-ticked. (However, running at real-time priority does give more reliable and better 
audio/MIDI performance on most PCs.) 

• Compatibility: very large values in organ definitions for inertia linkages' acceleration/damping that yielded 
numeric overflows were being handled differently in v5.0.0 compared to v4, resulting in Inspired 
Acoustics' native combination steppers not working. Inertia linkages have now been changed to yield the 
same results in such circumstances, for compatibility with those sample sets. 

• Platforms: macOS 10.15 is now listed as supported. However, please note that there are currently some 
known minor compatibility issues, which are listed in the ‘Known issues’ section in this release notice. 

• Bug-fix: a crash (or menu action being ignored) was possible with a particular (unusual) combination of 
settings when stopping audio. 

• Bug-fix: a crash was occasionally possible (since v3) if clicking the OK button multiple times on a settings 
screen immediately after changing a drop-down setting that enabled/disabled other settings on the 
screen (as the v5 'General settings | Audio device and channels' screen's audio device setting does if 
changing between two devices of different driver types). 

• Bug-fix: any pipes' perspectives routed to empty audio mixer bus groups would incorrectly sound through 
audio mixer primary bus 1. 
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• If audio settings have been migrated from Hauptwerk v4, newly-installed organs' ranks are now routed by 
default to the migrated v4 default audio mixer bus group (provided that the group is still non-empty). 

• To help avoid confusion, when the General Configuration Wizard runs automatically upon first launch 
after upgrading from a pre-v5 version, the (recommended) options to discard/reset migrated Hauptwerk 
v4 audio settings/routing are no longer ticked by default if you previously had more than one audio 
output group configured in your previous Hauptwerk version. Likewise for the option to reset (migrated) 
rank routing when the Organ Configuration Wizard runs automatically when first loading each organ after 
upgrading from a pre-v5 version. Also, the 'enable MIDI output' option on the General Configuration 
Wizard now defaults to 'yes' if any MIDI OUT ports were previously enabled for console MIDI output. Also, 
the 'Assorted MIDI or USB music keyboards/synths' MIDI hardware console type has been changed to 
allow MIDI output (so that it behaves in the same way as the 'DIY/home-made or modified MIDI console' 
console type). Also, a note has been added to the General Configuration Wizard to emphasize that saying 
'no' when asked whether to enable MIDI output will clear MIDI settings for any virtual controls for which 
MIDI output is already configured. 

• For convenience (and consistency with Hauptwerk v4), the 'All perspectives: overall amplitude (dB)' 
adjustment is now selected by default on the 'Organ settings | Rank voicing ...' screen. 

• For convenience, when loading a newly-installed organ for the first time, if the default audio mixer bus 
group (group 5: 'Front 1/main', with default settings) has since been emptied by the user, then output 
perspective 1 of each of the organ's ranks is now routed by default to the first non-empty group 
(excluding groups 2-4, which are used for surround/3D audio with default settings). 

• The default for the 'Extra time to allow when starting audio on Windows if not running at real-time 
priority' advanced general preference has been reduced from 7 seconds to 3. (As with v5.0.0, you can still 
set the setting to 0, for no delay, if you prefer.) 

• The 'Console Windows Size' mini control panel is now positioned at the bottom (instead of the top) of the 
main window when no organ is loaded (as it was in Hauptwerk v4), to keep the width of main window less 
than 1024 on macOS, especially for compatibility with portrait-orientation 1920x1080 touch-screens. 

• The maximum MIDI note for bass splits on the Rank Routing to Audio Mixer Primary Bus Groups screen 
increased from 60 to 84. 

• An 'x' close-window button has been added to the title bars of the two voicing screens on Windows (in 
addition to the existing ‘Close’ button, and keyboard shortcuts for closing the window), for consistency 
with macOS and Hauptwerk v4. 

• Whilst an organ is loading, triggering any of the functions via MIDI to change/select the cued favorite 
organ, select a recent organ, or change/select the cued favorite object (of all types), now cancels the 
organ loading (as was technically possible in v4). 

• Diagnostics: a more-detailed error message is now reported if an operation fails due to the active 
connection to iLok Cloud or an iLok dongle having been lost. 

• Diagnostics: memory usage statistics are logged whenever stopping audio/MIDI or creating a diagnostic 
file. Additional memory statistics are also logged on Windows. 

• The installation/upgrade instructions sections in the user guide have been expanded. 

• Various other minor changes and fixes. 
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Changes in version 5.0.0 above version 4.2.1 

Advanced Edition only: audio routing, multiple audio output perspectives, and associated voicing changes 

Hauptwerk’s audio routing, and associated settings screens, have been re-designed from the ground up to be 
massively more powerful and convenient to use. 

(With the exception of changing the main audio driver itself, or its settings): 

• All audio/routing settings changes can be made fully in real-time without re-starting audio/MIDI. 

• Audio/routing settings changes take effect and can be heard immediately. 

• Audio/routing screens show real-time visual feedback so that it's easy to see what's being routed where 
as you play or change settings. 

• The audio/routing settings screens can be open and used simultaneously, so that you can immediately see 
how changes made on one screen affect any other. 

• Audio/routing screens allow multi-selection, so that you can change the settings quickly for multiple 
objects at once. 

Also: 

• (As covered separately in the next section) very high-performance impulse response reverb can be applied 
natively within Hauptwerk, without any third-party software or hardware needed. 

• Hauptwerk’s default audio routing settings are pre-configured so that surround/3D-sound, adding 
overall reverbs, sub-woofer mixes, and stereo recording mixes require just a very few clicks to 
configure, with no need to use or understand Hauptwerk’s underlying multi-channel audio functionality 
or associated screens. For any of these purposes, make sure you reset your audio routing settings when 
prompted when you first run Hauptwerk v5, then simply follow the instructions on the ‘General 
settings |Audio mixer’ screen to select the appropriate device channels for the relevant ‘master mix’ 
buses (and optionally to select reverbs for them), and (for surround/3D-sound) then use the ‘Organ 
settings | Voicing and surround/3D/perspective panning’ screen’s ‘Perspective mix: …’ adjustments to 
pan ranks to your surround/3D speaker pairs. 

• You can optionally configure up to 8 independent ‘mixer presets’ (complete sets of global audio routing 
and impulse response reverb settings) and apply different ones to different organs (via the ‘Organ 
settings | Organ preferences’ screen). 

• You can also adjust (scale) the ‘wetness’ of any impulse response reverbs you might have applied on 
the mixer overall, on a per-organ basis, via the new ‘View | Large … control panels (for this organ) | 
Audio … settings’ control panel. This provides a very simple and quick means to tweak reverb wetness, 
and/or disable reverb, on a per-organ basis. 

• Virtual pipe ranks can be panned in real-time amongst the stereo pairs within surround/3D speaker set-
ups, and voiced separately for those pairs. 

• (As covered separately in the voicing section) the rank voicing screen now allows multiple ranks to be 
voiced/routed/panned simultaneously. 

• It's now possible even for very complex audio routing to be configured quickly, in real-time, and much 
more easily. 

• Changing an audio routing setting will never now cause an organ to re-load, or for its data cache to be 
regenerated. 
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In order to take best advantage of Hauptwerk v5's capabilities, we strongly recommend resetting your audio 
configuration when prompted when first launching v5, and then adjusting/configuring it as desired (although any 
existing v2/v3/v4 audio settings will be migrated where possible if you don't choose that reset option). If you do 
wish to migrate your v2/v3/v4 audio settings then please make sure that your audio interface is connected and 
turned on before launching v5 for the first time, so that its channels can be queried as needed for the migration. 
The 'General settings | General configuration wizard' and 'Organ settings | Organ configuration wizard' functions 
may also be used to reset audio routing back to defaults. 

The audio device/driver is now selected via the new 'General settings | Audio device and channels' screen. The 
screen optionally allows you to rename or remap channels, and has a new option for additional internal audio 
buffering, which might help on some PCs prone to audio glitches. Only a single device/driver can now be in use 
(which is necessary to ensure audio synchronization), but Windows ASIO devices and Mac CoreAudio devices with 
up to 1024 channels are now supported (although only the first 128 allow renaming/remapping on the 'General 
settings | Audio device and channels' screen). (Windows DirectSound drivers aren't recommended, since they 
don't usually perform as well, and they only allow a single pair of channels in Hauptwerk.) [*] 

By default, audio routing settings are configured with appropriate mixer buses and groups for basic stereo output, 
as well as for 2D-surround (front and back stereo pairs of speakers) and for 3D-surround output (front/back 
upper/lower stereo pairs), and for multi-channel output with four pairs of speakers in the single (main) group, so 
that everything is defaulted appropriately for basic stereo output, and simultaneously also for surround output, 
and simultaneously also for four-stereo-pair multi-channel output. This makes it extremely quick and easy to 
configure Hauptwerk for those purposes, as well as for applying overall impulse response reverbs, avoiding any 
need to use or understand most of Hauptwerk’s routing or multi-channel audio screens or settings. 

There are eight independent and complete sets of mixer/group settings for the ‘General settings | Audio mixer’ 
and (for multi-channel audio) ‘General settings | Advanced audio … | Audio mixer bus groups’ screens. These 
independent sets of settings are termed ‘mixer presets’, and can be found and configured via the left-hand browse 
lists on those screens. You can select which of the eight mixer presets should apply to each individual organ via the 
‘Organ settings | Organ preferences | Audio mixer preset’ screen tab. This allows you to apply different audio 
routings and impulse response reverbs to different organs. For example, you could set up one preset for wet 
stereo organs, another for wet surround organs, and another for dry organs (for adding impulse response reverb). 
[Unlike Hauptwerk v4, it is no longer necessary to use the ‘Hauptwerk (alt config N)’ desktop shortcuts for that 
purpose.] 

As always, the on-screen help on each of the new screens provides more detailed information and hints. For 
convenience, there's also a new 'Audio Mixer, Routing and Voicing/Panning Settings' large control panel (available 
via the View menu) for opening the relevant screens, as well as convenience buttons on the relevant screens 
themselves to show the others that relate to them. As mentioned above, the new control panel also allows you to 
adjust (scale) the ‘wetness’ of any impulse response reverbs that you might have applied on the mixer overall, on a 
per-organ basis. This provides a very simple and quick means to tweak reverb wetness, and/or disable reverb, on a 
per-organ basis. 

Please consult the ‘Audio routing and impulse response reverb’ sections in the main Hauptwerk user guide (on 
the Help menu in Hauptwerk) for full details about Hauptwerk’s new audio routing capabilities and how to use 
them, including step-by-step tutorials for the most common modes of use (including 2D/3D surround, multi-
channel audio, etc.). 

The remainder of this section describes in detail the changes relating to multi-channel audio (whereby ranks are 
distributed automatically or manually amongst multiple speakers for purposes other than surround/3D-sound). 
You can skip all of the following unless you plan to use multi-channel audio specifically: 
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Central to the new design are the new 'General settings | Audio mixer ...' screen (which replaces Hauptwerk 
version 4's 'General settings | Audio outputs' screen), and the new 'General settings | Advanced audio … | Audio 
mixer bus groups ...' screen (which replaces Hauptwerk v4's 'General settings | Audio output groups' screen). 

(Similar to Hauptwerk v4), the core underlying concept is that virtual pipe ranks are routed via groups to primary 
mixer buses, and that mixer buses may output audio to audio device channels and/or to other 'mix buses' (akin to 
aux sends routing to aux buses on a mixing desk). Ranks are now routed to groups using the new 'Organ settings | 
Advanced audio … | Rank routing …' screen (whereas in v4 the 'Organ | Load organ, adjusting rank …' screen 
needed to be used prior to loading an organ). The screen can usually also be reached be right-clicking on the 
desired stop on the virtual console. 

It's now also possible optionally to route any given pipe rank to up to four different groups simultaneously using 
the four new 'output perspectives' on the (renamed) 'Organ settings | Rank voicing and surround/3D/perspective 
panning' screen, and the corresponding 'output perspective' settings on the 'Organ settings | Advanced audio … | 
Rank routing …' screen. The new 'Perspective mix: source … to output … 1-4 …' voicing adjustments are used to 
route the output from any given pipe rank to any or all of the four 'output perspectives', and the four perspectives 
may be voiced independently. These output perspectives would normally be used for (and are configured by 
default for) surround/3D-sound use, allowing you to control the mix sent from each virtual rank/pipe to each of 
your surround/3D set-up’s stereo speaker pairs (front/main, front/upper, rear/main, rear/upper), thus effectively 
positioning the rank virtually within the your listening room, optionally also voicing it differently for the various 
speaker pairs. (Alternatively, for example, you could use one of the perspectives for a rear 'reverb' mix, adjusting 
the levels and voicing sent to it independently for each rank.) For surround/3D sound use it is thus no longer 
necessary to route ranks manually to separate groups – instead (with the default audio routing settings) you simply 
pan each virtual rank as appropriate via the voicing/panning screen. 

(For each mixer preset) the audio mixer has a fixed number of 1024 'primary buses' (to which ranks can be routed, 
via groups), 8 'intermediate mix buses', and 8 'master mix buses'. It allows primary buses optionally to be routed to 
any or all of the mix buses (of either type), and the 'intermediate mix buses' optionally to be routed to any or all of 
the 'master mix buses'. For example, you might route some ranks to a group of several stereo speaker pairs, whilst 
simultaneously sending the audio from all of those pairs' primary buses to a mix bus used for adding reverb. 

All mixer buses are stereo, but you can still choose to load ranks in mono (via the 'Organ | Load organ, adjusting 
rank audio memory options' screen). You can also output any or all buses to any stereo pair of audio device 
channels (speaker pairs), or to mono device channels (speakers). Hauptwerk's built-in audio recorder can also 
record any or all mixer buses (in stereo). 

It's now possible for any primary mixer bus to be a member of more than one bus group, and to include any given 
bus in multiple groups, and any given audio device channel may be used for any number of mixer buses. 

As with Hauptwerk v4, when a rank is routed to a group that contains more than one bus, a 'bus allocation 
algorithm' is used to define how individual pipes in the rank get routed to the individual mixer buses within the 
group. However, unlike v4, the algorithms can now be specified at the per-rank level (instead of the per-group 
level), via the new 'Organ settings | Advanced audio … | Rank routing …' screen, thus allowing different algorithms 
to be used for different organs and/or ranks when routing to any given group, if so desired. 

There are also a number of new algorithms, including 'dynamic' ones, which allocate pipes to mixer buses in a 
group on a per-key-press basis, such that any given pipe is allowed to move around within the group for 
subsequent key presses. (Dynamic algorithms might not strictly be realistic acoustically, but they do potentially 
allow more even load balancing for any given number of speakers.) It's also now possible to specify algorithm note 
offsets manually, so that (for non-dynamic algorithms) you have full control over which pipe in a rank will end up 
being allocated to which specific mixer bus/speaker, whereas previously that was usually determined by the 
creator of the organ (sample set) being used. As with Hauptwerk v4, the lower/bass part of any given rank may 
optionally be routed differently from its upper/main part. 
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To help familiarize yourself with the way the new multi-channel audio routing works, with an organ loaded, we 
recommend opening all of the following screens at the same time: 

1. 'Organ settings | Rank voicing and surround/3D/perspective panning'. 

2. 'Organ settings | Advanced audio … | Rank routing …'. 

3. 'General settings | Advanced audio … | Audio mixer bus groups …'. 

4. 'General settings | Audio mixer …'. 

Conceptually, a pipe/rank’s audio flows through all of those screens in the order above, i.e.: 

Rank voicing/panning -> Rank routing to audio mixer bus groups -> Audio mixer bus groups -> Audio mixer 

(… and then to the ‘General settings | Audio device …’ screen.) 

With a single stop drawn, play different notes and watch how the virtual activity LEDs flash down the left-hand 
sides of the (last three) screens to see how pipes are being routed as you play, and as you change settings on the 
screens. (Please note that the activity LEDs on the 'Organ settings | Advanced audio … | Rank routing …' and 
'General settings | Advanced audio … | Audio mixer bus groups …' screens only flash momentarily as you press 
each key, whereas those on the 'General settings | Audio mixer …' remain lit whilst a bus is receiving any audio 
signal.) 

[Please note that when loading any given organ for the first time in Hauptwerk v5, the organ’s internal data cache 
will need to be (re-)generated, which might be slow, but subsequently the organ should load faster.] 

 [* Please also note that technically Hauptwerk v5's audio configuration also has the following limitations 
compared to v4: a maximum of 16 total mixer ‘mix’ buses (the equivalents of v4's aux mix-down outputs) is 
allowed, and the left and right device channels selected for any given mixer bus (v4 audio output) when stereo 
should usually be consecutive (although if you really want to use non-consecutive channels then channel orders can 
be remapped manually via the 'General settings | Audio device and channels' screen).] 

Advanced Edition only: native impulse response convolution reverb 

Hauptwerk now has a native, very high-performance impulse response convolution reverb engine built in, allowing 
high-quality real-time reverb to be added easily and natively, with no additional hardware or software needed. 

It's a 'true stereo' (four-channel) convolution reverb engine, and is designed to be able to handle large numbers of 
simultaneous instances with low CPU load (especially with modern multi-core CPUs that support AVX CPU 
instruction sets), thus allowing realistic 'virtual acoustics' optionally to be configured (with many virtual sound 
sources to distribute pipes/ranks within virtual space). In fact, for small organs, and with a powerful computer, 
even per-pipe convolution (with a separate impulse response applied for each pipe’s mixer bus individually) should 
be possible. In itself, Hauptwerk’s reverb engine adds no additional latency (sound delay).  

A selection of high-quality impulse response reverbs is included (pre-installed) with Hauptwerk, and additional 
impulse response reverbs can be installed using 'File | Install …' within Hauptwerk. They need to be in Hauptwerk 
format, and we anticipate that plenty of reverbs will be available from sample set developers and others over time. 
(Sample set/reverb developers: please use the new 'Design tools | View ... reverb format documentation' menu 
function in Hauptwerk for details of the necessary format.) 

Once installed, you can apply any reverb to any of the buses on the 'General settings | Audio mixer' screen. For 
example, for basic use, you could just apply a single reverb to Hauptwerk's overall stereo output via an appropriate 
'master mix bus', or for more complex use you could apply different reverbs to individual mixer buses. 
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Reverb wet/dry mix, wet level, and wet pre-delay may all be adjusted via the mixer screen. An impulse response 
reverb may also optionally be faded out (truncated), to help reduce CPU load and/or to help make it seem 'drier'. 

As mentioned in the previous section, you can also adjust (scale) the ‘wetness’ of any impulse response reverbs 
you might have applied on the mixer overall, on a per-organ basis, via the new ‘View | Large … control panels (for 
this organ) | Audio … settings’ control panel. This provides a very simple and quick means to tweak reverb 
wetness, and/or disable reverb, on a per-organ basis. ‘Mixer presets’ can also be used to set up different reverbs 
for different organs. 

Licensing changes 

• Hauptwerk is now licensed via the PACE iLok system (instead of the ‘Hauptwerk USB key’ HASP dongle 
that was used for v4). 

• To use or evaluate Hauptwerk, you need to have/create an account on https://www.ilok.com/, and to 
have installed the current version of iLok License Manager, which may be downloaded there. iLok License 
Manager is used for viewing/activating/deactivating/transferring/renewing licenses, as well as for logging 
into/out of iLok Cloud (see below). Some commercial Hauptwerk sample sets are also licensed via the iLok 
system, and licenses for them may viewed/activated/deactivated/transferred/renewed in iLok License 
Manager, in the same way as for licenses for Hauptwerk itself. Whenever you have been sent an 
activation code for a license purchased (whether for Hauptwerk, or for a sample set), you can enter it in 
iLok License Manager using ‘Licenses | Redeem Activation Code’ (then exit and re-launch Hauptwerk, if it 
was running). 

• You can choose to use any given license in either of two ways: 

o The license may be activated to an iLok3/iLok2 hardware USB dongle. This method requires no 
permanent Internet connection to the Hauptwerk computer, since licenses within the dongle 
may be activated/deactivated/transferred (and renewed, in the case of subscription licenses) by 
temporarily moving the dongle to a separate Internet-connected computer (which has the iLok 
License Manager software installed) whenever needed. The dongle may be moved freely around 
amongst several computers, provided that the dongle is attached to whichever computer has 
Hauptwerk running at the time. (Please make sure that you never attach or detach the dongle 
whilst Hauptwerk is actually running.) Hauptwerk will not run without the iLok dongle containing 
the Hauptwerk license attached. A dongle is the required ‘licensing location’ for computers that 
do not have a reliable always-on Internet connection (such as for most church installations, or for 
PCs for which an Internet connection is not used in order to avoid audio glitches). An iLok dongle 
is not provided with a Hauptwerk license, but iLok3 dongles may be purchased readily from 
musical equipment shops. If you already have an iLok2+ dongle then you can also use that 
dongle for Hauptwerk; licenses for multiple software products from different companies may be 
present within any given dongle. Alternatively: 

o You can instead use the license from any computer into which iLok License Manager is currently 
logged into an iLok Cloud session. This is termed ‘iLok Cloud licensing’.  The ‘iLok Cloud’ FAQ 
covers how to log into/out from iLok Cloud: https://www.ilok.com/#!faq. When a license is used 
in this way no hardware dongle is needed, but a reliable always-on Internet connection is 
required. You can freely switch between using different computers by closing Hauptwerk and 
closing the iLok Cloud session (via iLok License Manager) on one computer, then opening an iLok 
Cloud session (via iLok License Manager) and launching Hauptwerk on another, with the iLok 
Cloud system ensuring that only one instance of the license can be in use at any given time. 

• You are able to move your license(s) freely around amongst iLok dongles and/or the iLok Cloud, and 
Hauptwerk licenses are neither computer-specific, nor platform-specific. 

https://www.ilok.com/
https://www.ilok.com/#!faq
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• For Hauptwerk, and Milan Digital Audio’s sample sets, and for some third-party producers’ sample sets, 
you may also transfer/sell your licenses to other users, without any approval or actions needed on our 
part. The iLok License Manager software has the necessary functionality and documentation for 
moving/transferring licenses, in conjunction with the iLok website (https://www.ilok.com/), and PACE 
should be contacted directly (via the iLok website) for any support needed with moving or transferring 
licenses. Their ‘Your Licenses’ FAQ covers how to transfer licenses to a different user (a different iLok 
account name): https://www.ilok.com/#!faq, for which PACE will charge an administrative fee to you 
directly (as covered in their FAQ). 

• There is a new edition of Hauptwerk, named the Hauptwerk Lite Edition, which is available on a 
subscription basis (only). It supersedes the previous Hauptwerk v4 Basic Edition, and has the same 
functional limitations that the v4 Basic Edition had (compared to the v4 Advanced Edition), except that: 

o It places no limit on the amount of memory an organ is allowed to use (instead of v4’s 3 GB). 
(Polyphony remains limited to 1024, as for the v4 Basic Edition.) 

o The Hauptwerk AU/VST Link (and AU/VST support) is not available. 

o No technical support is available for the Custom Organ Design Module (although the module may 
still be used within it). 

• The Basic and Free editions of Hauptwerk are no longer available. 

• Yearly subscription licenses (which will work for all versions from 5 onwards) are available for the 
Hauptwerk Advanced Edition, and for the Hauptwerk Lite Edition, and perpetual Hauptwerk v5-specifc 
licenses are available for the Advanced Edition (only). Any type of license (Advanced or Lite, subscription 
of perpetual) may be used on either an iLok3/iLok2 dongle, or with iLok Cloud. If using a subscription 
license on an iLok dongle then the subscription needs to be renewed, and then refreshed on the dongle, 
before it expires each year, for which the dongle will need to be connected (at least temporarily) to a 
computer that has an Internet connection and iLok License Manager installed. An Internet connection is 
only required when refreshing the license on the dongle, and the refresh operation may be performed by 
moving the dongle temporarily to an Internet-connected computer that has iLok License Manager 
installed. Subscription licenses for Hauptwerk itself, and for Milan Digital Audio’s samples sets, are 
available via the Hauptwerk website. 

• The Public Installation License has been discontinued, and any v5 license type (Advanced or Lite, 
perpetual or subscription) may now be used/installed in public installations, without additional licensing 
requirements. 

• The new audio routing and impulse response convolution reverb functionality is available in the Advanced 
Edition only. In the Lite Edition, only a single stereo audio output is supported, as for v4. 

https://www.ilok.com/
https://www.ilok.com/#!faq
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• Technical support is now available from Milan Digital Audio via Hauptwerk Technical Support Incidents 
raised via our website support ticket only. If your Hauptwerk v5 license (or license upgrade) is purchased 
from Milan Digital Audio directly (not via a reseller), then some free support incidents are included, as 
follows. To receive support from Milan Digital Audio in other cases a Hauptwerk Technical Support 
Incident, or support plan, needs to be purchased from Milan Digital Audio. For further details please see 
the Hauptwerk license agreement on our website (or on the Help menu in this version of Hauptwerk), and 
Hauptwerk Technical Support Incident and support plan pricing on our website: 

o Hauptwerk Advanced Edition v5-specific perpetual licenses/upgrades: at most 4 free support 
incidents within the first 90 days from the date of license (or license upgrade) purchase. 

o Hauptwerk Advanced Edition subscription licenses/upgrades: at most 4 free support incidents 
within the first 90 days from the date of first purchase in the first year, and at most 2 free 
support incidents within the first 90 days of each subsequent renewed year. 

o Hauptwerk Lite Edition subscription licenses/upgrades: at most 1 free support incident within the 
first 90 days from the date of first purchase in the first year (and none in subsequent renewed 
years). 

• If upgrading Hauptwerk from v2-4, then please note that the previous ‘Hauptwerk USB key’ HASP dongle 
that was used for v2-4 cannot be used for licensing this version of Hauptwerk, or for licensing sample sets. 

• If upgrading Hauptwerk from v2-4, then please note that current version of Hauptwerk isn’t compatible 
directly with copy-protected sample sets that were created for pre-v5 versions, so please contact the 
makers of any such sample sets to obtain upgraded v5+ compatible versions if needed. If you have 
purchased an upgrade to v5, once Hauptwerk v5+ has been installed, you will need to migrate any sample 
set licenses that you may have from your pre-v5 ‘Hauptwerk USB Key’ HASP dongle (which will remove 
them permanently from that dongle, rendering it no longer usable), activate the replacement v5+ licenses 
for those sample sets in iLok License Manager, then use File | Install … to install the updated v5+ 
compatible versions of the sample sets. Your settings, voicing, and combinations for those sample sets 
shouldn’t be lost in the process. When purchasing an upgrade to version 5 you will be sent instructions for 
the sample set license migration process (which involves using a special menu function once, then 
submitting the resulting file via a website form). Important: once you have used the special menu 
function to migrate your pre-v5 Hauptwerk sample set licenses to v5+ there is no way to reinstate those 
pre-v5 sample set licenses, nor to reinstate your pre-v5 Hauptwerk license itself. Hence please make sure 
that you do indeed wish to upgrade before you use the menu function to migrate your pre-v5 sample set 
licenses. 

• Before subsequently installing any new copy-protected iLok-licensed sample set (or impulse response 
reverb set), you should download the current ‘Hauptwerk licensing packages’ Hauptwerk component 
package file from Milan Digital Audio: https://www.hauptwerk.com/licensingpackages. Use ‘File | Install 
…’ in Hauptwerk to install it. [The ‘Hauptwerk licensing packages’ link between Hauptwerk and 
Hauptwerk’s iLok-based licensing system. They aren’t licenses in themselves. The (master) ‘Hauptwerk 
licensing packages’ component package file contains the current versions of the licensing packages for all 
current copy-protected iLok-licensed sample sets (from all makers) and is hosted ‘centrally’ for download 
from Milan Digital Audio.] 

• Hauptwerk v5 may be evaluated only once (for any given iLok account), and evaluation is limited to 14 
days. During that period Hauptwerk will have the full functionality of the Advanced Edition (without any 
periodic triangle chime, audio muting, or any other functional limitation). 

• 7-day trial activation codes are available for Milan Digital Audio’s sample sets, and trial activation codes 
are available for some third-party producers’ sample sets. Sample set trial activations may also be used 
when evaluating Hauptwerk itself. 

https://www.hauptwerk.com/licensingpackages
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• For further details about the new iLok-based licensing system, please see the following section in the 
main Hauptwerk user guide (on our website (or on the Help menu in this version of Hauptwerk): 

o Licensing, editions, and technical support. 

o Hauptwerk prerequisites. 

o Installing/un-installing/upgrading organs, temperaments, or reverbs (the component installer). 

Advanced Edition only: other new rank voicing adjustment functionality 

On the (renamed) 'Organ settings | Rank voicing and surround/3D/perspective panning' screen you may now 
select multiple ranks/layers at once to adjust their settings simultaneously. The bank of sliders controls will then 
show the value of that adjustment parameter for each note in the (primary) selected rank whose name is shown 
above the bank of sliders. Note/MSTR/QUICK-slider adjustments are relative to their current parameter values 
unless the ALT key is held down, in which case value adjustments are absolute. A note slider will be highlighted in 
yellow if (and only if) you have more than one rank selected, and the adjustment parameter values for that note 
for ranks other than the displayed (primary) selected rank differ from that of the displayed (primary) selected rank. 
Thus if a note slider is highlighted in yellow then it indicates that the parameter value of the note is currently set 
differently for the various selected ranks, and that moving the slider will adjust those various values (relative to 
their current parameter values, if the ALT key is not held down, or setting them all to the displayed slider value, if 
the ALT key is held down). 

The voicing screen also now has settings to allow the stereo balance of most modulations/filters to be adjusted. 
For example, you might make a modeled tremulant or swell box modulate the amplitude of a rank more strongly in 
the right-hand channel, whilst making it affect its harmonic content more strongly in the left-hand, thus giving a 
dynamic stereo effect. These new stereo-balance voicing adjustments also allow values beyond +/- 100 percent, 
with such values inverting the polarity of modulations. Most other modulation depth adjustments also now allow 
negative values, for polarity inversion. 

The voicing screen also allows real-time, per-output-perspective (for surround/3D-sound), release tail truncation 
(in addition to the existing non-real-time release tail truncation available via the 'Organ | Load organ, adjusting 
rank audio memory options' screen), which can help to make a wet sample set seems a little 'drier' than it would 
normally. (Please note that the real-time truncation functionality doesn't reduce the memory required for the 
organ, and you need to retrigger any held notes to hear changes.) 

Performance and audio realism 

• Performance (polyphony that can potentially be achieved, subject to the polyphony limit of the 
Hauptwerk edition) on a given computer should be a little better in general, and significantly so with 
stereo or surround sample sets. (Please note the standard polyphony testing organs are mono, but stereo 
organs should now achieve very nearly the same levels of performance as mono organs.) 

• Additionally, performance on a given computer should be significantly better on CPUs that support the 
AVX, AVX-2, or AVX-512 instruction sets (such as most mid/higher-end CPUs made since about 2011). 

• There should no longer be a significant difference in polyphony from loading ranks with memory 
compression enabled. 

• Hauptwerk's background models (modeled tremulants, relay, and the Advanced Edition's wind supply 
model) should be smoother, improving overall quality and realism. 

• Playing with multiple stops drawn should sound a little more realistic. 

• PCs: organs should unload much faster on recent Windows 10 versions if Windows' page file is completely 
disabled (as a work-around to a performance bug relating to locked memory in recent Windows 10 
updates, which Microsoft is aware of and aims to address properly in the longer-term). 
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• Hauptwerk should be a bit more resilient to audio glitches and CPU load spikes on Windows in general 
(although the PC still needs to be working well enough to handle real-time low-latency audio in general, as 
reported by utilities such as Resplendence Software’s LatencyMon). 

Platform support and prerequisites changes 

• Macs: Hauptwerk fully supports, and is now only officially supported on, macOS ‘Mojave’ 10.14 and 
macOS ‘High Sierra’ 10.13.6 and later. (It might possibly still work on OS X 10.12 or 10.11, but we don’t 
test or officially support them. It definitely won’t work on 10.10 or earlier.) 

• PCs: Hauptwerk fully supports current/recent 64-bit versions of Windows 10, and is now only officially 
supported on 64-bit Windows 10 and 64-bit Windows 7. (It might possibly still work on some other 64-bit 
pre-Windows 10 versions of Windows, but we don’t test or officially support them. It definitely won’t 
work on 32-bit versions of Windows, or on 32-bit PCs.) 

• Basic support has been added for automatic screen scaling for 'high-DPI' screens, such as Mac 'Retina' and 
similar laptops. (Hauptwerk's screens should now scale automatically on high-DPI screens.) 

• For traditional-DPI (non-’Retina’) monitors: Hauptwerk requires a minimum display resolution of 1024 
pixels horizontally by 900 pixels vertically for your (primary) monitor. For high-DPI monitors (such as Apple 
‘Retina’ displays): Hauptwerk requires a minimum display resolution of 1536 pixels horizontally by 1350 
pixels vertically for your (primary) monitor. 

• A CPU that supports at least the SSE2 instruction set is still required (as for Hauptwerk v4), but in order to 
make best use of the new functionality in the Advanced Edition we strongly recommend a CPU with AVX, 
AVX2, or Intel AVX-512 (such as a recent Intel i9 or modern i7 processor made since about 2011). 

• An audio interface and ASIO/Core Audio driver that supports power-of-two buffer sizes (128, 256, 512, 
1024, 2048, or 4096) is recommended for lowest latency. 

• The Hauptwerk AU/VST Link (Advanced Edition only) is supported with current versions of Cubase (10.x), 
Logic Pro X (10.4.x), Reaper (5.9x), and Garage Band (10.3.x). 

• The amount of RAM a given sample set needs might be slightly different (in some cases higher, in others 
lower), compared to Hauptwerk version 4. 

• To use or evaluate Hauptwerk, you need to have/create an account on https://www.ilok.com/, and to 
have installed the current version of iLok License Manager (which may be downloaded from there) on 
your Hauptwerk computer. 

• If you wish to license Hauptwerk via a dongle (as opposed to via iLok Cloud) then you will need to 
have/buy an iLok3 (or iLok2) dongle, and have a spare USB port to which to attach it. Alternatively, if you 
wish to use iLok Cloud for licensing, then your Hauptwerk computer will need a reliable always-on 
Internet connection. Please see also the Licensing changes section above for further details. 

Novation Launchpad 'mark 2' model support 

Hauptwerk now has native support for the Novation Launchpad 'mark 2' model (whilst remaining compatible with 
the original 'mark 1'). Novation Launchpads are popular and cost-effective means for controlling Hauptwerk's 
virtual stops and pistons, allowing stop states to be seen by way of the assigned Launchpad buttons' internal 
lamps. 

https://www.ilok.com/
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(As for Hauptwerk version 4), to use a Launchpad with Hauptwerk, please ensure that the Launchpad is connected 
to the computer before launching Hauptwerk, then ensure that it's enabled in the left-hand 'Console MIDI ...' 
columns on both of the 'MIDI IN ports' and the 'MIDI OUT ports' tabs of the 'General settings | MIDI ports' screen. 
Then, with your organ loaded, use standard right-click auto-detection to assign the Launchpad's buttons as desired 
to virtual stops/pistons/switches. You should see an option on the auto-detection screen allowing you to select the 
desired behavior for the Launchpad button's internal lamp. 

Changes for the Custom Organ Design Module ('CODM') 

• Hauptwerk now has native functionality (on the 'Design tools' menu) to export/import CODM organ 
definitions to/from SQLite databases, for easier manipulation of their data via the power of the SQL 
language. Please see the CODM user's guide (also via the 'Design tools' menu) for details. 

• The CODM organ definition format documentation is now available in HTML format via a new 'View | 
Custom Organ Design Module ... format documentation' menu function (instead of within the CODM's 
main user guide). Changes to the CODM organ definition format in each Hauptwerk version are now 
documented via this new menu function, and may be found by searching the resulting HTML document 
for 'HWvx.x.x' (or appropriate sub-strings, where each 'x' represents a numerical version digit). Please 
search the document for 'HWv5.0.0' to see the full list of changes for v5.0.0 (although, there are no major 
changes to the CODM organ definition format itself in this version). 

• The CODM's user guide has been converted to portrait format, and is now available via the 'Design tools' 
menu (instead of the Help menu). 

• The maximum font size allowed within CODM organ definitions has been increased, to allow for 'high-DPI' 
('Retina') displays. 

• There is a new option on the 'Design tools | Load organ ...' screen to reset user rank routing options. 

• No technical support will be available for the Custom Organ Design Module for the Basic and Free editions 
(although the module may still be used in them). 

• Bug-fix: percussive disengaging key action noises for divisions wouldn't work properly unless the 
PercussiveEngagingKeyActionNoise_ChooseMIDINoteNumRandomly CODM organ definition attribute was 
Y (since Hauptwerk v4.0.0). 

• Bug-fix: the CODM example St. Anne’s Moseley organ definitions had too much ‘wind supply wobble’ 
(since v3.0.0). 

Changes for sample set developers 

• Hauptwerk now has native functionality (on the 'Design tools' menu) to export/import 'full-format' organ 
definitions to/from SQLite databases, for easier manipulation of their data via the power of the SQL 
language. [**] 

• The organ 'full-format' definition format is now documented in HTML format via a new menu function on 
the 'Design tools' menu. Changes to the organ definition format in each Hauptwerk version are now 
documented via this new menu function, and may be found by searching the resulting HTML document 
for 'HWvx.x.x' (or appropriate sub-strings, where each 'x' represents a numerical version digit). Please 
search the document for 'HWv5.0.0' to see the full list of changes for v5.0.0. [**] 

• The organ definition format now allows pipe modulations with inverted polarity, and for modulation 
depths to be adjusted within the stereo field, in accord with the corresponding voicing adjustments. 
(Please see the format documentation for details.) 
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• Native component installer support has been added for multi-part archives in WinRAR v5's default (v5) 
archive format. To create multi-part RARs, please now select the default 'RAR' (not 'RAR4') archive format 
in WinRAR, specify the desired volume size, do not select the 'Old style volume names' option, let WinRAR 
generate the files, then rename them to '... .part1.CompPkg_Hauptwerk_rar', ..., '... 
.partN..CompPkg_Hauptwerk_rar'. 

• The maximum font size allowed within organ definitions has been increased, to allow for 'high-DPI' 
('Retina') displays. 

• The minimum output sample rate is now 44.1 kHz. 

• It is no longer necessary for a dummy wind compartment linkage to exist if the organ doesn't use the wind 
supply model. 

• There is a new option on the 'Design tools | Load organ ...' screen to reset user rank routing options. 

• The previous general preference to disable auto-compacting of organ settings has been renamed to clarify 
that it only does so for voicing data. 

• There is a new 'Design tools | Generate a new ... UUID' screen (which is currently relevant only for 
packaging impulse response reverbs). 

• The maximum number of allowed console display tabs has been increased to 32. 

• Bug-fix: ThreePositionSwitchImage organ definition objects weren't been working properly (since v2.0.0). 

• Specifying an invalid value of 0 for 
WindCompartmentLinkage.MassFlowRateKilogramsPerSecAtReferencePressureDiff in an organ definition 
file would be accepted by Hauptwerk (causing it to be rounded it to the nearest valid value of 1e-32), but 
rejected by SQLite if exporting to a database. 1e-32 is now used as a default for the attribute for 
compatibility to allow such organ definition files to continue to load, and to export without error. 

• Important: since v5+ cannot load copy-protected sample sets for pre-v5 versions, it is imperative that all 
pre-v5 protected sample sets should be re-protected for v5+, and made available for download to their 
end-users (and/or publicly), as a matter of the highest possible priority. If you are a sample set developer 
who uses Hauptwerk’s sample set copy-protection system, then please contact us privately for the 
necessary details (if we haven’t contacted you already). 

[**] Please see the current version of the Creating Sample Sets for Hauptwerk guide for details. The guide, and the 
relevant 'Design tools' menu functions, are made available to licensed Advanced Edition users upon request. 

Other changes 

• The bit-depth used by Hauptwerk's built-in audio recorder is now set via the 'General settings | General 
preferences' screen, and defaults to 32-bit floating-point format (which default audio players on current 
operating systems should be able to play). 

• The 'Sequencer MIDI IN/OUT' ports have been renamed to 'Hauptwerk MIDI recorder/player external MIDI 
IN/OUT' ports, to help to avoid confusion. The menu function that shows their documentation is now 
named 'Recording | View Hauptwerk MIDI recorder/player fixed, predefined MIDI implementation (for this 
organ)'. Also, the MIDI sequencing and MIDI recorder/player MIDI implementation reference sections in 
the main Hauptwerk user guide have been reworked to make it clearer which sub-sections would be 
appropriate for most MIDI sequencer/DAW users. 

• Changing the 'Reduce relay/MIDI/tremulant/model response/accuracy/quality for max polyphony' organ 
preference no longer requires an organ to re-load. 

• Changing any of the following no longer requires held notes to be re-triggered: voicing amplitude levels, 
voicing pans, and audio level trim. 
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• There is a new ‘Clock’ mini control panel (accessible via the View menu) that shows the computer’s 
current time, particularly for the benefit of those who use Hauptwerk in full-screen mode. (Hauptwerk 
doesn’t transmit that time via MIDI output, in order to avoid excessive MIDI traffic.) 

• Macs: the Hauptwerk AU/VST Link (Advanced Edition only) Mac Audio Unit plug-in now provides 16 stereo 
outputs (rather than a single 32-channel output), for better multi-channel audio compatibility with Logic 
and Reaper. In order that Logic detects the changed configuration after upgrading: close any Logic 
projects, then use 'Logic Pro X | Preferences | Plug-in Manager', highlight the Milan Digital Audio 
'Hauptwerk AU Link' plug-in, and click the 'Reset and Rescan Selection' button. Logic should report 'AU 
validation succeeded'. 

• Installer: to help avoid issues with file/folder permissions, by default for new installation the Hauptwerk 
installer now installs its data files into a Hauptwerk folder within your computer account’s home folder 
(instead of at the top level of your computer’s main drive). As before, the ‘Custom’ option in the installer 
allows those default locations to be changed (but please do ensure that your computer account is allowed 
to write to any folders you may select). When upgrading, your existing installation locations will be used. 

• Installer: for best compatibility with recent macOS versions, on Macs (only), the installer no longer 
requires you to enter your computer account’s password, and will no longer run with administrator 
privileges (so please do ensure that your computer account is allowed to write to any folders you may 
select). Also, the Hauptwerk AU/VST Link plug-ins are now installed within your computer account’s 
private plug-ins library (the /Library/Audio/Plug-ins within your computer account’s home folder, as 
opposed to the system-wide one, /Library/Audio/Plug-ins). IMPORTANT: If upgrading from version 4 or 
earlier, please note that plug-ins from the earlier version won’t be removed by this version’s installer, so 
please make sure you use the current plug-in versions (if applicable). 

• Installer: on macOS Apple’s Java for OS X (Java 6 run-time) is no longer required. (Hauptwerk’s installer 
instead now installs it own private installation of the Java 8 run-time, which is needed and used only by 
the installer and un-installer.) Please note that on some Macs a spurious ‘HauptwerkJavaRuntime’ entry 
might appear in macOS’ Launchpad application, which should be ignored. 

• For Windows ASIO and Mac Core Audio drivers, and for the Hauptwerk AU/VST Plug-in Link, audio buffer 
sizes of 128 sample frames (about 2.7 ms of latency at 48 kHz), 2048 frames, and 4096 frames, are all now 
supported (whereas previously the smallest allowed was 256 frames, and the largest 1024. 

• For the Hauptwerk AU/VST Plug-in Link, audio buffer sizes must also now be specified within Hauptwerk 
(since Hauptwerk requires its buffers’ sizes to be powers of two and of a constant size, so that zero-
latency impulse response reverb is possible within Hauptwerk). For good performance, the individual 
buffer size set in Hauptwerk should be no larger than the AU/VST host’s buffer size and the total amount 
of Hauptwerk buffering (Hauptwerk individual buffer size multiplied by number of buffers) should be at 
least at much as the AU/VST host’s buffer size. If you are certain that the host’s buffer size will always be 
exactly the same as the buffer size set in Hauptwerk then you can set the number of buffers in Hauptwerk 
to 1, which should give the best possible performance and lowest latency. For the AU/VST Link the default 
Hauptwerk buffer values (size=256, number=4) should be reliable for any host buffer size in between 256 
and 1024, giving a reasonable balance of performance. 

• An organ may no longer be loaded in 14-bit resolution. (16-bit is now the minimum.) 

• A new advanced general preference 'Try to run Hauptwerk at real-time priority on Windows' has been 
added. On some PCs, running at real-time priority gives the most reliable audio/MIDI performance on 
Windows. However, automatically running at real-time priority usually requires that Hauptwerk be 
launched with Windows administrator privileges, in which case Hauptwerk's PDF documentation might 
not be accessible. (Running at real-time priority might possibly cause performance problems with other 
software running at the same time on the computer. The setting currently has no effect on other 
platforms.) 
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• A new advanced general preference ‘Extra time to allow when starting audio on Windows if not running at 
real-time priority’ has been added. On Windows, if Hauptwerk isn’t set to (or isn’t allowed to) run at real-
time priority, then some PCs are prone to audio an audio glitch/CPU-spike straight after starting audio. 
This setting usually guards against that, but makes starting audio slower. Specifically: when not running at 
real-time priority, Windows sometimes takes several seconds to move audio threads around amongst CPU 
cores, which might result in audio glitches. The setting makes Hauptwerk allow time for that to have 
happened before it starts streaming audio. We found about 3-7 seconds to work reliably on most PCs. 
Running Hauptwerk at real-time priority (either manually via Windows settings, or allowing Hauptwerk to 
do it automatically by running Hauptwerk with Windows administrator privileges, keeping the ‘Try to run 
Hauptwerk at real-time priority on Windows’ preference ticked) should avoid the issue entirely, and 
usually gives more stable audio/MIDI overall anyway. (The setting currently has no effect on other 
platforms.) 

• The method used to determine whether sample set data caches need to be regenerated no longer 
depends upon timestamps (to make it resilient to failing computer clock batteries). 

• For users with multiple iLok dongles (or iLok Cloud accounts) each containing valid/active Hauptwerk 
sample set licenses: swapping dongles/accounts (when Hauptwerk isn't running) no longer causes sample 
set caches to be regenerated. (However, the dongle/account must still have a valid/active license for any 
sample set being loaded.) 

• Macs: Hauptwerk attempts to prevent macOS putting it to sleep via App Nap (which could potentially 
cause performance issues and lack of responsiveness to MIDI and dropped USB/MIDI connections). 

• Spurious progress indicators now shouldn't normally open behind other windows, which sometimes 
caused confusion with file browsers that remember their positions in recent operating system versions. 

• When auto-detecting switches, any incoming MIDI sys-ex messages that originated from Hauptwerk are 
now ignored (for compatibility with MIDI hardware that requires a feedback loop). 

• If upgrading from Hauptwerk versions 2 or 3 directly, MIDI settings will no longer be migrated. (We 
strongly recommended resetting all MIDI settings when upgrading to v4 anyway.) Likewise, v2/v3 audio 
engine preferences and organ preferences are no longer migrated. 

• Documentation: tables of contents have been added to generated combination set text listings and MIDI 
recorder/player MIDI implementation documents. 

• The polyphony testing organs now allow filters to be disabled, and allow rank memory options to be 
accessed/changed (via the usual 'Organ | Load organ, adjusting rank audio memory options' screen), for 
performance testing. (Previously all ranks were fixed at 16-bit, uncompressed, single loops.) 

• PCs: if necessary, Hauptwerk will wait and re-try briefly for an ASIO audio driver's sample rate to change 
asynchronously, before logging a warning, for compatibility with the current MOTU AVB ASIO driver. 

• The MIDI piston/switch contact de-bouncing function time interval has been increased a little, for better 
compatibility with some types of MIDI pistons/switches. 

• The MIDI console status output system has a new Boolean variable (parameter ID 86) IsMIDIReady, and 
IsOrganReady has been renamed to IsOrganAndAudioAndMIDIReady. IsOrganAndAudioAndMIDIReady 
and IsReadyForUserInput are now always sent first, and all of them now explicitly send ‘off’ messages 
when deactivating. 

• The MIDI console status output system has a new CC variable (parameter ID 87) 
MasterReverbWetnessScalarRawCCVal (0=0%, 127=100%) for the corresponding control’s value on the 
'Audio Mixer, Routing and Voicing/Panning Settings' large control panel. 

• Disabling interpolation no longer saves additional CPU overheads, and neither does having no filters at all 
enabled (compared to having one filter enabled). 
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• PCs: support has been add for an ASIO driver audio stream format which we understand is needed by 
Marian audio interfaces’ ASIO driver. 

• The toggling MIDI program change stop switch MIDI event type (as used by Johannus/Makin/Wyvern) has 
been extended for compatibility with Musicom systems. 

• Documentation: the LCD panel MIDI implementation section in the Hauptwerk user guide has been 
clarified regarding 7-bit character sets. 

• Diagnostics: the computer's primary display's size, resolutions and DPI settings are now logged. 

• PCs: Hauptwerk’s installer no longer includes an option to configure Windows to start Hauptwerk 
automatically when the computer boots (since the preferred method in Windows 10 is for the user to 
control that directly from Task Manager). 

• The ‘MIDI hardware/console type’ setting on the General Configuration Wizard now defaults from its 
corresponding general preference when the latter has previously been set. 

• The ‘master’ and ‘quick’ sliders on the rank voicing screen now always ‘zero’ to their center positions 
(instead of to the default value for the selected adjustment). 

• Selecting a menu item to open a real-time settings screen or voicing screen now always brings the screen 
to the foreground if it’s already open. 

• Various other minor cosmetic/usability improvements to settings screens, screen names, and menu 
function names. 

Bug fixes 

• Slightly too much 'free' RAM could be reported on some computers (mainly Macs), resulting in Hauptwerk 
allowing the RAM to be over-filled, potentially allowing the computer to become sluggish or freeze. 

• Multiple loops with identical starting positions within a sample could cause a crash (since v2.0.0), notably 
with the original version of the OrganArt Media Steinkirchen sample set. 

• If a floating control panel or piston toolbar had input focus then computer key presses mapped to 
functions didn't work (since v4.0.0). 

• MIDI Master Fine-Tuning MIDI sys-ex messages weren't being interpreted correctly (since v4.1.0). 

• LCD system: if very large numbers of LCD panels were used, some could fail to be cleared when stopping 
MIDI drivers (since v2.0.0, but more noticeable with v4.2.0+). 

• Loading a pre-v4 combination set for the first time that also had last been loaded in an older/different 
organ definition (with the same OrganID) could cause a crash (since v4.0.0). 

• Combination sets that hadn't been saved since upgrading to v.4.2+ could be slow to load. 

• Under some circumstances the large floating control panels incorrectly allowed docking at the top/bottom 
of the main window. 

• Selecting a View menu item by right-clicking on certain display items on the Audio, MIDI and Performance 
large control panel could incorrectly open the settings screen relating to the other items on that menu 
(since v4.0.0). 

• Lengths of cross-fades to release samples could incorrectly depend slightly upon user-selected 
pitch/temperament/tuning when the sample set's cache was last generated (since v2.0.0). 

• Various other minor fixes. 
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Known issues 

• macOS 10.13 and later: if you close Hauptwerk when in full-screen mode, then the windows might not get 
restored properly to full-screen when next launching Hauptwerk. As a work-around, if you want to use 
full-screen mode, then please always exit full-screen mode before closing Hauptwerk, then re-enter it 
when next launching Hauptwerk. (This is a confirmed high-priority compatibility issue with macOS 10.13+ 
in the multi-platform library that we use internally for Hauptwerk. We need to await a fix from the makers 
of that library.) 

• macOS 10.15: selecting a different reverb on the ‘General settings | Audio mixer’ sometimes doesn’t 
result in the text and controls on the screen initially being redrawn properly. (We aim to move to the 
latest version of the development tools/libraries for the next Hauptwerk maintenance release, which we 
hope should address any such remaining macOS 10.15 compatibility issues.) 

• macOS 10.15: you need to launch Hauptwerk’s installer by right-clicking on it and selecting ‘Open’ (since 
the installer isn’t yet ‘notarized’ by Apple, which macOS 10.15 requires by default in order to be able to 
launch it by double-clicking on it). 

• If you want your computer’s operating system to launch Hauptwerk automatically when the computer 
boots, and if, on your computer, you find that doing so results in a ‘license not found’ error when the 
operating system launches Hauptwerk (due to the operating system launching Hauptwerk before the iLok 
system has finished starting), then you may instead need to launch Hauptwerk via a script/batch file that 
(for example) waits for a few seconds before it launches Hauptwerk. 

• Hauptwerk v5 should use a similar amount of memory for the data for any given organ itself, compared to 
v4, but v5 does need to use some additional RAM for its surround/3D-cabapable audio engine and native 
reverb capabilities (with the exact figure depending on various factors, especially the polyphony limit 
setting and whether any reverbs are loaded), compared to v4.  Typically, the v5 Advanced Edition is likely 
to need around 200-250 MB more memory than v4 did. Hence if certain organs were almost filling your 
computer's memory in v4 then you will need to reduce their memory requirements via the 'Organ | Load 
organ, adjusting rank audio memory options' screen (by disabling some ranks, or by setting them to load 
in lower audio resolutions, or with multiple loops or releases disabled, for example). As with any 
Hauptwerk version, it’s extremely important not to over-fill your computer’s, otherwise you may risk 
system instability. 

• If you previously upgraded from pre-v5 version to v5.0.0 (as opposed to upgrading from a pre-v5 version 
directly to this version) and in v5.0.0 you retained/migrated your pre-v5 audio settings/routing, and you 
had installed and loaded any new organs in v5.0.0 (and/or in v5.0.0 you had subsequently used the 
General Configuration Wizard to reset your audio settings, but not also used the Organ Configuration 
Wizard to reset your rank audio routing for some organs), then (due to a bug that existed in v5.0.0) you 
might find that you hear no audio from those organs. In that case, with each of those organs loaded in 
turn, please simply use the ‘Organ settings | Organ Configuration Wizard’ from the menu in Hauptwerk, 
keeping just the ‘Reset rank routing …’ option ticked. (Alternatively, or additionally, if you wish you could 
use the ‘Organ settings | Advanced audio routing … | Rank routing …’ screen to select your desired audio 
mixer bus group for output perspective 1 for each rank.) 
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